
NCH Software

PhotoStage Slideshow Producer

This user guide has been created for use with

PhotoStage Slideshow Producer Version 10.xx

©NCH Software



Technical Support
If you have difficulties using PhotoStage Slideshow Producer please read the applicable topic 
before requesting support. If your problem is not covered in this user guide please view the 
up-to-date PhotoStage Slideshow Producer Online Technical Support at 

www.nchsoftware.com/slideshow/support.html. 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions
If you have any suggestions for improvements to PhotoStage Slideshow Producer, or 
suggestions for other related software that you might need, please post it on our Suggestions 
page at www.nch.com.au/suggestions/index.html. 

Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nchsoftware.com/slideshow/support.html
www.nch.com.au/suggestions/index.html
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Introduction
PhotoStage is a program for creating video slideshows from your digital pictures, photos, and 
video files.
Features  
● Load a variety of image file formats such as .jpg, .gif, .tiff, .png, .bmp, and many others. 
● Supports a large number of video formats (.avi, .mkv, .mp4, .wmv, etc.) as well as a wide 

variety of audio formats (.m4a, .mid, .mp3, .wav, .wma, etc.). 
● Write your video slideshow to any format to play it anywhere: DVD, Windows PC, Mac, and 

CD. Many portable devices are also supported: iPod, PSP, mobile phone, and iPhone. 
● PhotoStage allows you to upload exported video files to Dropbox, Flickr, Google Drive, 

OneDrive, Vimeo, and YouTube. 
● Narrate your slideshow using the microphone. 
● Preview your slideshow live as you edit. 
● Add effects and transitions including cross fade and color adjustments. 
● Simple, intuitive and powerful interface. 
System Requirements  
● Windows XP / Vista / 7 / 8 / 10
● Windows compatible sound card
Note: Some effects require DirectX 9.0c compatible 3D accelerated video card, with up-to-date 
drivers. If the system doesn't have one the effect Spin will not be available. 
Recommended  
● Dual Core CPU
PhotoStage is just one component of the NCH Software Suite. If you have not done so already, 
please visit http://www.nchsoftware.com/software/index.html to download many other related 
programs. 
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How to Use PhotoStage
This is an overview of how to use PhotoStage to create a video slideshow.
Adding Photos 
Start your project by adding files to the Media List area. Every image or video you add to 
PhotoStage is considered to be a slide. To add files to PhotoStage, either click Add Media 
dropdown button on the toolbar and choose to whether Add Media from Computer  or Add 
Media from Camera/Phone, or one of the Add Photos, Add Videos  or Add Audio buttons 
to the right of the Media List. In the file browser dialog, select the files you wish to use and click 

. 
Once your files have been added, if you wish to remove any of them, right click on the files and 
select Remove item(s)  from the menu. 
Adding Media to the Slideshow 
Once you have added all of your media to the Media List, you can then add them to the 
slideshow. You can do this two ways: 
1. From the Media List area: Just select the file in the Media List and, with the left mouse 

button pushed, drag it down onto the slideshow area. Alternatively, you can right click on 
the selected file and choose Add items to the Slideshow from the menu. Your slide has 
now been added to the slideshow and is part of your project. 

2. Add to Slideshow  button: Click on the files you want to move so they are highlighted, then 
press the Add to Slideshow  button, at the right side of the Media List. 

Once your files have been added, if you wish to remove any of them, right click on the slide 
and select Remove selected slides(s) from the menu, or Remove all slides  to remove all 
the slides. In alternative you can use the delete button (with a red 'X' icon) below the preview 
panel, this will remove the slide that is currently visible in the preview. 

Adjusting the Duration of a Slide 
If you want to change how long a slide is displayed for, you can click on the length of time 
displayed below the slide on the slideshow or by double clicking on the slide. A dialog will 
appear, showing the slide and a textbox with the current duration in it. Change the number to 
be the amount of seconds you want the slide to display for, then click Apply  to apply the new 
duration to the slide. 
Editing Slides on the Slideshow 
You can add effects  to your slides on the slideshow by first clicking on the slide, then on one 
of the effect tabs located on the left of the preview, you can choose between Edit, Effects , An
imations  and Text. The tabs are accessible also from the Video top menu. To apply 
effects to multiple slides at once, select the first slide, hold the Shift key and left-click on the 
last slide you want to select, then select the effect you want to apply from the Video -> Apply 
Effect  menu. To learn more about the different effects, please see Effects. 
To add a transition  between slides, click the button between two slides on the slideshow and 
pick the transition you wish to apply, change the duration if desired, then click Apply . 
Alternatively, you can select the first slide, then click Video -> Transitions... in the top menu. 
You can also multi-select slides and apply a single transition to many slides. To learn more 
about the different transitions, please see Transitions. 
Sorting Slides on the Slideshow 
You can sort your slides on the slideshow by right clicking anywhere in the video slideshow 
and selecting Reorder All/Selected Slides from the context menu, a context submenu will 
open showing the possible ways to sort your slides. If more then one slide is selected then only 
the selected slides will be sorted. 

Selecting Multiple Slides on the Slideshow  
There are three ways to select multiple slides on the slideshow: 
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1. By holding the Shift  key and then pressing left or right buttons on the keyboard. 
2. By holding the Shift  key then clicking the last slide you want to select. 
3. Double clicking on a slide then dragging left or right to select multiple slides. 
Adding Audio and Narration 
You can add a soundtrack to your slideshow by first adding the audio file to the Media List area 
(using the Add Media button from the toolbar). If your audio file is not long enough for the 
slideshow, you can add another audio file to the Soundtrack area after it. 
Alternatively, you can choose to add sound effects from the NCH Sound Library  by 
right-clicking any empty space on the soundtrack and selecting Add Sound From NCH 
Sound Effect Library from the context menu. In the same way cliparts can be added from the 
NCH Clipart Library  by right-clicking any empty space on the slideshow and selecting Add 
Clipart From NCH Clipart Library from the context menu. The file you choose will be added 
at the location you have right-clicked. 
You can also add narration to your slideshow. First select the slide you would like to begin 
narrating from, then click on Narrate button from the toolbar. Configure the narration options if 
needed, then press the Record  button to begin recording. When you have finished narrating, 
click the Stop  button. The narration will automatically be added to your slideshow from the 
point you selected. 
Only one sound file will be heard at a time, and sound files will automatically fade to allow 
another sound file to be heard. For example, if you have added a video slide, its audio will be 
heard over the soundtrack or narration. A narration will be heard over the soundtrack.

Saving and Loading Your Video Project  
If you want to save your project, select File -> Save Project As  from the menu and select a 
destination file to save your project to. Saving this way will allow you to come back and edit 
your slideshow project later. 

To load the saved project select File -> Open Project from the menu. Then select your saved 
project file. 
Warning : When you save your project file you do not actually save your slides into it. Only 
filenames are saved. If you want all the data including slides, narrations and soundtracks to be 
safe do not rename, delete or move any files that are used in the project from their original 
folders. If you want to move your project together with your files you have to go to Files -> 
Back Up Project Files to Folder. 
Creating the Movie Slideshow  
Once you have finished putting all your pictures, videos, music, and narrations together, you 
still need to build the slideshow. Open the Video Output Setup window by clicking the Export  
button on the toolbar. Select the destination device and format you want to build your project 
for. Change the name of your output video file in the Save Destination field. There is a help 
page for every destination type (access them by pressing the F1 key while you have the page 
you need help with open). 
Once you have selected the output format and save options, click the Create button at the 
bottom of the tab to create the movie. If you have not saved the project, a dialog will ask if you 
want to save before creating the movie. 
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Command Line Options
Adding files to PhotoStage can be done using the command line. The PhotoStage executable 
is usually located at "C:\Program Files\NCH Software\PhotoStage\photostage.exe". The usage 
of command line is: 

Usage: photostage.exe [file(s) to add] 
where: 
File(s) to Add contains a list of files to be added to PhotoStage. Each entry should be an 
absolute path separated by a space. Files will be automatically added to the sequence. 
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Media Tab
This page describes the Media tab. For a general overview on using PhotoStage, please see 
How To Use PhotoStage.  
Using the Media Tab 
The Media tab shows a list of all the files you want to use in your project. This can include 
photos and other images, videos, and audio files.
● To add files to the list, press one of the Add Photos, Add Audio or Add Videos  buttons, 

depending on what file type you want to add. Browse to the files you want to add, select 
them, then press Open. 

● To remove files from the list, first select them in the list, then press Delete on your 
keyboard. 

● To put files into your slideshow, either click and drag them from the list to the slideshow 
(the gray area below the timeline), or select them in the list and press the Add to 
Slideshow button. 

● To insert a blank slide to your slideshow, press the Add a Blank Slide button. To choose 
the color of the slide before adding it, press the arrow on the right side of the button. 

● Clips can be sorted by Name or Creation Date  and also Ascending or Descending, this 
can be done by changing the drop down Sort media by  . 

Organizing Files in Folders  
A folder can be created in the list to organize your files. To create a new folder, use Create 
new folder  button then add files inside it by dragging files to the folder or opening the folder 
then adding files using Add Photos, Add Audio or Add Videos  buttons. 
Currently, nested folders is not supported. To go back to the parent folder, use Return to 
parent folder button. 
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Quick Create Dialog
Use the Quick Create dialog to quickly create a slideshow using a folder of images. You can 
open the Quick Create dialog by pressing the Wizard button on the toolbar. 
To create a slideshow using the Quick Create dialog, follow these steps:
1. Choose the folder of images you want to use by clicking the Browse button at the top of the 

dialog.
2. Decide whether to include any folders inside the main folder you specified in the last step. If 

you want to include all the folders inside the main folder, check the Include Subfolders 
box. 

3. You can also include the files already added inside the media bin by checking the Include 
Media Bin  box. 

4. If you want, you can change which images from the selected folder will be added. To select 
which images will be used, press the Select button. (By default, all images and videos 
from the selected folder will be added.) 

5. Choose how long you want each image to display for in the Default input inside Image 
Display Length  group. 

6. Alternatively, after you have selected a sound file below you can select the Fit all images 
to soundtrack  option, which will automatically adjust your images so they will end at the 
same time as your sound file. 

7. Choose a sound file if you would like. If you want to use one from the NCH sound library, 
choose Use audio from NCH Sound Library  from the Sound drop-down list. Otherwise 
choose Use an audio file from my computer to add a sound file you have stored on your 
computer. Alternatively you can select Use all in sound folder to select a folder containing 
sound clips to be imported in the slideshow. The last option is Use all in image folder , this 
option will import all the sound clips found in the selected image folder in the slideshow. 

8. If you want to add a theme to your slideshow select one from the drop-down list. In the Bac
kground Theme  dialog you will be able to preview the images used as background 
images, select the Intro / Outro Title text to be used in the first / last sequence clips that 
will be added to the slideshow. 

9. Enter the duration and select a transition type from the drop-down list, or select the Rando
mize  checkbox to use random transitions. The transition will be applied to change 
between one image and the next. 

10. Press Create to finish creating your slideshow. If Save slideshow after creation  was 
checked, your video will be exported straight away. 
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Editing in an External Editor
To edit a file you have added to PhotoStage in an external editor:
First, right-click the file in the Media List and select Edit in external editor  (for image and 
audio files) or Edit outside PhotoStage  (for video files) from the context menu. 
If you have specified an external editor in the Other tab of the options dialog, then the editor 
you have chosen will open. Otherwise, the default editor will open (WavePad for audio files, 
PhotoPad for image files, VideoPad for video files). 

Make any changes in the external editor and press save. Close the external editor when the 
save is complete.
Change back to PhotoStage. There should be a message saying "Editing in an external 
editor... Press Ok when done". Press the Ok button. 
PhotoStage will reload the file so that your changes are visible. Note that for a video, the 
original file may not be overwritten by the external video editor (e.g. VideoPad). In that case, 
you will need to add the new file (created by the video editor) manually into PhotoStage.
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Exporting Individual Frames
You can export an individual frame from your slideshow by first navigating to the frame (so that 
it is visible in the slideshow preview area), then clicking the Slideshow -> Take Snapshot 
menu.
The frame will be saved to the Snapshots folder specified on the Media Files  tab of the option
s dialog. 
Note: You can export your entire slideshow as a series of images by clicking the Export  
button on the toolbar and choosing Image Sequence as the output format. 
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Adding Blank Slides
Use blank slides to add a fade-in effect to the beginning of your slideshow, a title to the 
beginning of your slideshow, credits to the end of the slideshow, breaks between scenes, or to 
allow extra time for audio to be heard before or after the slideshow. 

You can add blank slides to your slideshow by clicking the Add Blank button on the toolbar, or 
the Add a Blank Slide button beside the media list. If you click one of those buttons, a dialog 
will appear that lets you choose whether to add a solid color blank clip or a gradient clip. 
Once you have clicked one of these buttons, the Select Position For a New Slide dialog will 
appear. Your choices are: 
● Slider's position  Adding blank slides to the slider's position in the project allows you to 

add slides in the middle of the slideshow. Blank slides in the middle of the show can be 
used to create breaks between scenes, or as a background for captions. 

● Beginning of the timeline Adding a blank slide to the beginning of your project allows you 
to force a set amount of blank screen before your main movie begins. This can be helpful if 
you want to begin your movie with a buildup of music, a voice over, or adding a title. 

● End of a track  Adding a blank slide to the end of your project allows you to force a set 
amount of blank screen at the end of your movie. This could be helpful if you still have 
audio that you want played, but no video to show, or if you want to add credits or an ending 
slide. 
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Downloading from Cloud Services
You can add media files from Dropbox, Google Drive  or One Drive . To do so, select the 
Cloud menu from the toolbar and select from one of the supported cloud services. You will 
then be redirected to the login page and will be asked to enter your credentials. 

Selecting files to download 
After successful login, the cloud file explorer will be displayed to let you choose the files to 
download (multiple files are supported). Only video, audio and image files supported by 
PhotoStage can be downloaded. For Google Drive, it will let you choose for files to download 
inside the PhotoStage folder in your remote drive. 

Adding downloaded files to sequence 
If there are files downloaded successfully, you will be asked if these will be added to sequence 
or just to media bin. 
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Select Position For New Slide
When adding slides to the slideshow, the Select Position For a New Slide  dialog will appear, 
depending on the settings for new slide positions set in the Options dialog. Your choices are: 
● Slider's position  Adding slides to the slider's position in the project allows you to add 

slides in the middle of the slideshow. 
● Beginning of the timeline All slides you are adding will be inserted before slides already 

on the slideshow. 
● End of a track  All slides you are adding will be placed after slides already on the 

slideshow. 
See Also:  Adding Blank Slides 
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Background Theme
If you wish to add a theme to your slideshow you can do it using the Quick Create Dialog  and 
selecting a theme from the Theme drop-down list or clicking on the Select... button next to it, 
doing so will open the Background Theme dialog. 
In this dialog you will be able to: 
● Select between the various themes that are available using the Theme pull-down list found 

in the top left corner of the dialog. When you select a theme the images in the list will be 
updated. 

● Change the text used in the intro clip in the Intro Title  input. Note that the first clip will also 
contain an image overlay randomly picked from the added images. 

● Set the text to be used in the outro clip in the Outro Title input. 
Manage Themes 
Aside from themes built-in to PhotoStage, custom background theme images can be added 
using the Manage Themes dialog under the Background Themes effect panel. The dialog will 
let you add or delete themes (up to 20) and images for which you can specify a custom image 
name. A preview of the background images for each theme is also displayed. 
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Adjust your Slide
The Adjust your slide  dialog is different depending on what type of slide you have selected. 
To open the Adjust your slide  dialog, click on the length of time (for example, '3.0') written 
below the slide you want to adjust. 
Images and Photos:  
If you have selected an image, the Adjust your slide  dialog will have these controls: 
● Duration in seconds: Enter how long you would like your slide to be displayed for into the 

box. 
● Apply to All: Clicking Apply to All will apply the duration to all the slides in the slideshow. 
Blank Clip, Gradient and Pattern: 
Aside from the controls for Images and Photos, the following options can be used to switch 
between blank clip types: 
● Blank Clip: A solid colored blank clip 
● Gradient: A clip with a gradient background 
● Pattern: A clip with pattern background from a preset or custom image 
Videos:  
If you have selected a video, you will have these controls:
● Play, Pause, Go to Start, Go to End: Use these controls to navigate through your video.
● Start Time: Click the Start Time value to specify the place your video will start playing from. 

Alternatively, navigate to the place you would like it to start playing from and click the red Se
t input point to here  flag button. You can also drag the red Start Time arrow on the 
timeline below the preview. 

● End Time: Click the End Time value to specify the place your video will stop playing at. 
Alternatively, navigate to the place you would like it to stop playing at and click the blue Set 
output point to here flag button. You can also drag the blue End Time arrow on the 
timeline below the preview. 

● Save as new media: Pressing the Save as new media  button will save your video as a 
new media with the Start and End Time positions you have chosen. You can find the new 
media in the Media List. 

● Zoom in/out: Use the Zoom In or Zoom Out buttons or the shortcuts Num + / Num - to 
zoom in or out on the timeline. You could use this to help you position the Start and End 
Time positions at exactly the right place. 

● Shift+G: Press Shift+G to set the timeline position.
Sound:  
To open the Adjust Media dialog for a sound file, right click it and choose Adjust Duration. If 
you have selected a sound file, you will have these controls: 
● Play, Pause, Go to Start, Go to End: Use these controls to navigate through your sound file.
● Start Time: Click the Start Time value to specify the place your audio will start playing from. 

Alternatively, navigate to the place you would like it to start playing from and click the red Se
t input point to here  flag button. You can also drag the red Start Time arrow on the 
timeline below the preview. 

● End Time: Click the End Time value to specify the place your audio will stop playing at. 
Alternatively, navigate to the place you would like it to stop playing at and click the blue Set 
output point to here flag button. You can also drag the blue End Time arrow on the 
timeline below the preview. 

● Save as new media: Pressing the Save as new media  button will save your sound file as a 
new media with the Start and End Time positions you have chosen. You can find the new 
media in the Media List. 
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● Zoom in/out: Use the Zoom In or Zoom Out buttons or the shortcuts Num + / Num - to 
zoom in or out on the timeline. You could use this to help you position the Start and End 
Time positions at exactly the right place. 

● Shift+G: Press Shift+G to set the timeline position.
● Fade Points: The blue line in the middle of the sound wave preview shows the volume level 

the audio will fade to. For example, to gradually increase the volume, drag the end of the 
line upwards. Dragging in the middle of the line will create a new fade point. Right click to 
remove fade points.

● Fit Slides to Audio: Select from the list if you want to apply Fit Slides to Audio Duration, 
Loop Audio thru Slideshow or Fade Audio at End of Slides. Fit Slides to Audio Duration 
will adjust the video/image slide length to fit the duration of audio clips. Select Loop Audio 
thru Slideshow  to repeat the audio clip through the end of the slideshow. Fade Audio at 
End of Slides  will trim the audio to fit the video/image slides duration and apply a 1 
second fade out at the end. 

● Volume Control: Move the volume slider to adjust the volume of the sound clip.
● Amplify: Apply Amplify effect to the sound clip. 
When you have finished adjusting your media, press the Apply  button to save your changes 
and close the dialog. If Amplify has been applied, the effect will be added to the track effects 
list and the amplify settings will be reset.
Opening the Adjust your slide  dialog from the media tab will include an Add and Apply  
option, which will save your changes and automatically add the slide to the timeline.
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Recording Narrations
You can record your own narrations to add to your slideshow project. To record a narration 
select a slide on the slideshow and press the Narrate button on the toolbar or the Slideshow 
-> Narrate... , the Narration  dialog will show up. 
Preparing to Record 
To prepare to record a narration, first select the Sound In source from the Capture From drop 
menu. Then give your narration a name and select the location on your computer where you 
would like to save the recording. You are now ready to begin recording. 

Recording a Narration  
To begin to record a narration, first select the slide from the slideshow where you would like to 
begin narrating. Open the Narration  dialog. Then, click the Record button and begin talking. 
Once you have finished narrating, click the Stop button. Your narration will be automatically 
added to the slideshow at the slide you chose to begin narrating. If you would like to narrate at 
multiple locations in your project, you can repeat the process or Record/Stop as many times as 
you like.

Note that if you are narrating an image, PhotoStage will automatically increase the duration of 
the image to fit the length of the narration when the Automatically increase duration of 
narrated photo  is checked. 
Re-recording a Narration 
If you wish to redo the narration, click on the sound bar on the narration soundtrack to select it. 
Press the Delete shortcut key on your keyboard, and the narration will be deleted. Go through 
the recording process again. 
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Effects
Applying Effects  
On the left side of the preview pane, there are four effect tabs: Edit, Effects , Animations and 

. In each tab you can find different effects to apply to your slides. To apply an effect, click 
to select a slide in the slideshow and click one of the effects tabs. Select the effect you want to 
use from the Effects Library. You can then make adjustments using the preview window to see 
how the effect will look. 

To remove an effect, find it in the list titled Applied Effects, then 
Effects Without Options 
There are many effects that do not have settings for you to configure. These are usually 
self-explanatory, but if you don't know what they do, the best way to find out is to select them 
and then look at the preview. If you do not like the result, you can remove the effect by clicking 
the white X next to the effect in the Applied Effects list. 
The Effects without options are: 
● Auto Levels - this effect will automatically change the Brightness, Contrast and Gamma to 

their optimal values.
● Black and White - removes all pigmentation from the image and make black and white
● Edge Detection - darkens the image and highlights the strongest lines of the image
● Hue Cycle - changes the color of the slide continually by shifting through a range of colors
● Negative - swap all colors for their negative, as in a strip of camera film
● Old Film - makes the slide black and white and animates it with a shaky old film effect
● Posterize - applies a simplified color scheme to the image
● Raindrops - makes it look like raindrops are falling onto the slide
● Ripple - animates the slide with a ripple effect
● Sepia - removes most pigmentation, except for a reddish-brown hue, giving the picture an 

antique feel
● Spin - animates the slide by rotating the image
● Waves - animates the slide with a wavey effect
Effects with Options  
There are also effects with settings you can change. The options will appear below the heading 
in the Applied Effects list. You can show or hide the options by clicking the white arrow on the 
left of the effect name in the list. 

Auto Zoom  
The Auto Zoom option allows you to apply a quick zoom effect using preset options. The 
options are to zoom in or zoom out. 
Background 
Adds a background image to the slide. Select from the preset themes and images to add 
the background. 
Border 
Adds a border around the slide. Use the slider to adjust the width of the border and the color 
picker to choose the color to apply to the border. 
Brightness 
Use the track bars to adjust the Brightness of the Slide. 
Cartoon 
Makes the slide look like it's a cartoon. Use the track bars to adjust number of colors, edges 
and detail quality. 
Color Curves 
Remaps each color in the image or video from the original color to one defined by the color 
curve. 
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Contrast
Use the track bars to adjust the Contrast of the Slide. 
Crop 
This option allows you to select the region of a slide you would like to be displayed in your 
movie.
Select the region by dragging the corners of the red binding box with your mouse to the 
desired size and region.
Hold Shift key to keep proportions, or select a proportions option from the Keep 
Proportions  groupbox. 
Exposure  
This option will simulate camera under / over exposure. 
Fisheye  
Allows you to simulate a fisheye camera lense or to remove a fisheye effect. 
Gamma 
Use the track bars to adjust Gamma of the Slide. 
Hue 
This option will add a tinted hue to the slide. To select the color of the tint, slide the hue 
slider left or right until the desired color is selected. 
Mirror  
Mirrors one half of the slide on to the other half of the slide. With the pulldown list you can 
choose the direction of the mirror. 
Noise 
The Noise effect will add an animated television static noise to the slide. The amount of 
noise can be increased or decreased using the Noise slider. 
Pan  
The Pan Effect option allows you to apply a quick pan effect using preset options. The 
options are to pan left to right or pan right to left. 
Rotate 
You can rotate the slide by using the custom slider or clicking the 90 degrees clockwise or 
counter-clockwise buttons. 
Oil Painting 
Use the slider to change the brush size used to create the Oil Painting effect. Moving to the 
right will increase the brush size, while moving to the left will make the brush smaller. 
Pixelate 
Use the slider to increase or decrease the pixel size. Moving to the right will increase the 
size, while moving to the left will make the it smaller. 
Saturation 
A slide's color saturation can be increased or decreased using the Saturation tool. Slide the 
control to the left to desaturate the image, or to the right to saturate the color. 
Smoothness 
Use the slider to change the smoothness of the slide. Moving to the right will make the 
image sharper, while moving to the left will blur the image. 
Speed 
Use the Speed effect to change the speed of your slide. Dragging the slider to the right will 
increase speed, and dragging to the left will decrease speed. You can also change the 
playback direction by choosing the Play clip backwards  option. See the topic 
Speed Change and Playing Video Backwards for more information on this effect. 
Temperature  
Use the slider to change the temperature of the slide. This effect can be used to correct a 
clip that appears too yellow or too blue. A negative temperature cools the colors in the clip, 
a positive temperature warms the colors in the clip. 
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Tiles
Makes your image look like it's made of tiles. The following are the options that can be 
changed: 
● Quantity - Move the slider to change the number of tiles to be shown.
● Spacing - Move this slider to change the distance between each tile.
● Shape - The radio buttons will change the shape of the brick to be either rectangular or 

hexagonal.
Tint  
Tints the slide with an RGBA (red / green / blue / alpha) color value. Use the available 
sliders to change the Red, Green and Blue values. The Intensity slider changes the alpha 
value of the color. 
Image Overlay 
To add an image on top of the selected slide, click the Image Overlay option in the Effects 
tab and specify the desired image in the Image File field. The options for formatting the 
image are:
● Alignment - The nine alignment buttons represent where the image will be aligned in 

relation to the slide. For example, to center the image in the very middle of the slide, 
click the middle alignment button.

● Scroll - select a scroll option to have your image enter the screen and pass through 
during the duration of the slide.

● Size - Use the size slider to control how large the image appears on the slide.
● Margin - Use the margin slider to control the distance between the image and the border 

of the frame.
● Opacity - Use the opacity slider to control how opaque the image appears on the slide.
● Fade in and out - check this option to have the image fade in and out on the slide.
Two-Tone  
All dark areas of the image are replaced with First color and all light areas with Second 
color. 
Vignette 
The Vignette effect causes the slide to fade out to a specified color at it's edges. It can be 
used to simulate the light capturing properties of an old camera, or to add a soft elliptical 
border. Use the sliders to adjust the width and the intensity. To change the vignetting color, 
use the color picker. 

Zoom 
This option allows you to add zooming and panning to your slide. Change the selection by 
zooming in and out with the slider and resizing the red rectangle.
Select the position you would like the slide to start at on the first image.
Select the position you would like the slide to end at on the second image.
When changing either the start or end point, you can click the flag button next to the scale 
slider to see a bigger image with more options.
When you have applied the effect, the video will automatically zoom and pan from the size 
and location of the start point so that it ends up being the size and location of the end point 
by the time the slide has reached its end.
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Effects - Text
Text Overlay 
To add text to the selected slide, click the Text Overlay option in the Text tab and enter the 
desired text in the Text field. The options for formatting text are: 
● Font:  Select the desired font from the drop-menu directly beneath the text field. 
● Font format: Under the font selection, click B to make the text bold, I to italicize, and U to 

underline the text. The solid A button changes the color of the text, the outlined A (at far 
right) changes the color of the text outline. 

● Size: Use the size slider to control how large the text appears on the slide. 
● Color: The Text Color, Outline Color and Background Color controls, when clicked, will 

display a dialog where you can select the colors of your text. Note: Un-checking the Show 
outline check box will hide the text outline. 

● Opacity:  Use the opacity slider to control how opaque the text appears on the slide. 
● Shadow:  Check this option to add a shadow to the text. 
● Alignment: Selecting one of the alignment buttons will adjust the alignment of your text 

within the frame. 
● Scroll: Select a scroll option to have your text enter the screen and pass through during 

the duration of the slide. 
● Fade in and out:  Check this option to have the text fade in and out on the slide. 
Preset Text Overlays 
The following are Preset Text Overlays, the difference between these and the Text Overlay 
is that these will have a rendered background with different styles: 
● Comment - Top left: will add a text overlay in the top left corner of the slide with a 

background with a gradient from white to black; 
● Comment - Bottom right:  will add a text overlay in the bottom right corner of the slide with 

a background with a gradient from black to white; 
● Ruby - Center top: will add a text overlay in the top center of the slide with a red ruby like 

background; 
● Ruby - Center bottom: will add a text overlay in the bottom center of the slide with a red 

ruby like background; 
● Pill - Top left:  will add a text overlay in the top left corner of the slide with a blue pill like 

background; 
● Pill - Bottom left:  will add a text overlay in the bottom left corner of the slide with a blue pill 

like background; 
For the Preset Text Overlays these are the possible attributes that can be customized: 
● Font:  Select the desired font from the drop-menu directly beneath the text field. 
● Size: Use the size slider to control how large the text appears on the slide. 
● Fade in and out:  Check this option to have the text fade in and out on the slide. 
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Speed Change and Playing Video Backwards
Changing Playback Speed 
To adjust the speed of a slide, click on the slide in the slideshow, then open the Animations 
tab. Choose the Speed effect from the Effects Library. 
Enter a percentage into the box (or drag the trackbar) to update your slide with the new speed.
100% is the original speed of the slide. To slow your slide down, enter a lower percentage. To 
speed it up, enter a higher percentage. Some example values are:
● 1000 - The slide will play at 10 times the original speed.
● 200 - The slide will play at twice the original speed.
● 100 - The slide will play at the same speed as the original speed.
● 50 - The slide will play at half the original speed.
● 10 - The slide will play at one tenth of the original speed.
Playing Video Backwards  
To play video backwards, select the Play slide backwards  radio button option in the Speed 
Change effect. You can also adjust the speed if desired.
Removing Changes 
To remove the speed effects, click the white cross delete button on the top-right of the Speed 
Change item in the Effects applied to this slide  list. The slide will return to the original speed 
and playback direction (forwards). 
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Transitions
This tab allows you to create a transition between the slide you have selected and the next 
slide on the slideshow. Transitions will allow your slide to gradually transition to the next one. 
To open this tab, either select a slide on the timeline then select the Transitions  tab, or just 
click the Change transition effect  button between two slides on the timeline. 
Applying a Transition  
To use a different transition on the selected slide, just click on one of the transition icons. To 
change the duration of a transition, change the Duration in seconds value then click Apply  
to change only the selected slide's transition, or Apply to All to change the transitions on all 
slides. 

Clicking Apply to All gives an option to either update Transition Only , Duration Only  or 
. 

Removing a Transition 
To remove a transition from a slide, first select the slide you wish to remove the transition, 
open the Transitions  tab and then click on the Remove  button. 
Overlapping Transition 
Enabling Overlapping Transition will produce an overlap of the two clips instead of just using 
the start and end frames to produce the transition. This will shorten the transition and clip 
duration to create the overlap but will produce a smoother transition. 

How to begin a movie with a fade-in  
If you want your movie to start with fade-in effect, you need to insert a blank slide (using the Ad
d a Blank Slide  button on the Media tab) before the first slide of the slideshow. Click the 
arrow button to the right of the blank slide, and apply the Cross Fade transition. 
Transitions with Options  
The behavior of the following transitions can be changed using parameters in a property dialog 
shown when the transition is first applied or by clicking the Settings button:

Zoom 
Slide A (the slide being transitioned from) starts in the center of the frame. Adjust the Slide 
A End Position to select which direction it moves out of the frame to. 
Slide B (the slide being transitioned into) ends in the center of the frame. Adjust the Slide B 
Start Position  to select which direction it moves into the frame from. 
Values are specified as a percentage of the frame size. Negative values specify left and up, 
and positive values specify right and down. e.g., An X position of -50% means halfway out 
the left side of the frame. 

Slide  
In this dialog we can set how the slides will be moving.
On the left side we can set how the Previous Slide will be moving, on the right side we can 
set how the Next Slide will be moving when transitioning.
Select preset positions from the pull-down menus, or drag the blue boxes to the desired 
positions.
Duration determines the speed of the transition. 
Ease In / Out can be used to add some acceleration and deceleration to the movement. 
Morph  
Start by using "Draw lines" tool to draw lines around the main features of the two images. 
Look for similar features on both images and then draw lines on the first image. 
Corresponding lines will appear on the second image. Move these lines to match the 
features of the first image. Hold Ctrl to draw connected lines. Select a line and press Delete 
to remove it. You can also click "Remove all lines" button to clear all lines away.

"Undo" and "Redo" buttons are available to revert the changes.
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Use "Zoom In" and "Zoom out" buttons to zoom images. Use "Hand" tool to move zoomed 
image inside the control. Click "Draw lines" button again to return back to editing lines. 
Click "Change line color" button in case the default line color is not fancy enough.
You can also use "Crop" tool to ensure both images have the same proportions. Click "Crop 
left" button to crop the left image to the proportions of the right one, and vice versa. Red 
frame will appear on the image; adjust it and then press Enter to apply cropping or Escape 
to cancel.

Last thing you may need to do is to change the transition duration.
Now that you selected the image features and the duration, you can preview the results. 
Press "Play" to apply and preview the transition.
Blinds  
In this dialog, we can set direction and the number of blinds.
Direction of Blinds: Can be set to either Vertical or Horizontal.
Number of Blinds: Can be set from 1 to 20. 
Bounce 
In this dialog, we can set the desired positions and the number of bounces.
Previous Clip, default starts in the Center and select the desired end position.
Next Clip, default ends in the Center and select the desired start position. 
Number of Bounces: Sets on how many times the next clip bounces. 
Cube Spin 
In this dialog, we can set the distance and direction of the cube.
Distance: Sets on how farther the cube.
Direction: Right, Left, Up, or Down. This sets the desired Cube Spin direction origin. 
Click the check box to enable smooth spin.
Doors  
In this dialog, we can set the motion of the door.
Doors type sets the transition motion to either Close or Open.
Open: Previous clip acts as the door that opens and the next clip enters through it.
Close: Next clip acts as the door that closes and previous clip exits through it. 
Click the check box to enable zoom on entry or exit.
Puzzle 
In this dialog, we can set the dimensions of the pieces and fill type of the puzzle.
Pieces wide: Sets the width of the puzzle piece.
Pieces high: Sets the height of the puzzle piece. 
Fill type: Can be set to either Random Placement or Solve Puzzle.
Random Placement: Fills up the puzzle pieces randomly.
Solve Puzzle: Simulates solving of the puzzle. 
Tetromino 
In this dialog, we can set the complexity of the blocks.
Complexity: Ranges from 2 to 100. This sets the complexity of the blocks and how it is 
stacked. 
Tile Flip 
In this dialog, we can set the direction and number of tiles.
Click the check box to stagger the tiles.
Click the check box to flip the tiles. 
Set the number of horizontal tiles.
Set the number of vertical tiles. 
Direction: None, Right, Left, Up, Down, Up Right, Down Right, Up Left, or Down Left.
This sets the flipping direction of the tiles. 
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Working with Audio
The Audio Tracks  
The audio section of the slideshow is divided into two areas, one for your soundtrack and the 
other for your narration.
The top audio track is called the Soundtrack . This is a dedicated track for your slideshow's 
audio. You can drag audio files from the Media List on the Media tab to this track. 
The second track is called the Narration Track. This track will show any Narrations you have 
recorded. 
Fading 
If you have added a movie to your show, any sound it makes will automatically fade if you have 
a soundtrack playing. Your soundtrack and movie audio will both automatically fade whenever 
there is a narration playing.

Unlink Audio 
Allows you to separate the video and it's original audio. The audio is then placed in the Narratio
n Track .
Restore Audio 
This option will restore the default audio the video originally had.
How to mute native audio from video  
To mute a video, right click it in the audio track and choose Adjust Clip Volume. Check the M
ute clip  box, then click OK. 
How to save native audio from video  
You can save a video native audio as a separate file by right-clicking the video file in the Media 
List and choosing Save audio track as a separate file from the context menu. 
Trim audio to match length of slideshow 
Right click on an audio clip on either the Sound Track  or Narration Track, then select Trim 
audio to match length of slideshow to trim and fade the end of the audio file to match the length 
of the slides. 

Loop this clip until the end of the slideshow 
Right click on an audio clip on the Sound Track  or Narration Track. Select Loop this clip until 
the end of the slideshow to repeat the audio clip through the end of the slideshow. 

25



Video Processor
Video Processor Select which GPU to use for video processing. This takes effect the next 
time you run PhotoStage.
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NCH Sound Library
There are two ways of accessing the NCH Sound Library: 
● Right-clicking an empty space on the sound slideshow and selecting Add Sound From 

NCH Sound Effect Library  from the context menu. 
● Clicking the Slideshow menu at the top of the screen and selecting NCH Sound Effect 

Library. 
Once you have opened the Sound Library, you will see the following controls:
1. A list of folders on the left side: Each folder represents a category of sounds. Click one to 

either open a list of subfolders, or display the sounds in the main list view.
2. The main list view: This will be empty until you have selected a category. Once you have 

selected a category and sounds are displayed, you can click one in this list to select it.
3. Preview Sound area: To preview a sound, select one from the main list view, then press 

the play button to hear it. When you have finished, press Stop.
4. Download button: To download a sound, select it from the main list view then click the 

Download button.
When you press the download button, the sound will be downloaded (if it is not already) and 
added to the media list in your project. If you opened the Sound Library by right-clicking the 
audio track area, the sound will automatically be added to the slideshow where you have 
clicked.

You can also add the sound to the slideshow by dragging it from the media list to the slideshow.
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NCH Clipart Library
The NCH Clipart Library is a collection of hundreds of royalty-free images that can be added 
to your project. 
Open the library using one of the following ways: 

● Right-click in a clip bin and select Add Clipart From NCH Clipart Library. 
● Select Slideshow -> NCH Clipart Library 
Use the panel on the left to select a clipart category. When a category is selected, a list of 

clipart images will be displayed in the center of the dialog. Click on any image in the list to see 
a preview on the right side of the dialog. 

When you find a clipart image you like, click the Download button. Once the image has 
finished loading, the clipart image will be added to your project. 
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Previewing a Project
You can watch a full screen preview of what's on your slideshow, including effects and 
transitions, by pressing the Preview button on the toolbar. 
Press Esc to close the full screen preview. 

29



Output Options
To view the options for saving your slideshow, press the Export  button on the toolbar. 
These options allow you to select what format you would like your video to be created in. For 
more detailed help, go to the output page you would like more information about and click on 
the Help button at the bottom of that page. 
If you need to burn BluRay disc please export to mp4 and use Express Burn to burn the disc 
https://www.nch.com.au/burn/index.html. 
When you have finished choosing the output options, press the Create button at the bottom of 
the page to create the movie. 
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Resolve Missing Files
Resolve Missing Files Dialog 
The Resolve Missing Files dialog shows when you have attempted to load a project file and 
some of the files were missing. 
For each missing file, you will be prompted to either Delete or Resolve.
If you choose the Delete option for any missing file then that slide won't be loaded into the 
project.
If you choose the Resolve option then you will be prompted to browse to and choose a new 
file for that slide. Note that the new file must be of the same type as the original missing file. 
Once you have resolved or deleted each missing file, click Finish to continue loading the 
project. 
Media File Details  
To open the Media File Details  select the slide you want to view the details and then click on S
lide -> File Details... . A dialog will show the creation time, the duration of the media and the 
current path to the selected file. Clicking on Change... will open a dialog that will allow you to 
select another file of the same type to use. 
Missing Media Files  
In the Media List the missing files will be shown with red text. To resolve these open the Medi
a File Details , right click on the media you wish to resolve in the Media List and select D
etails... . 
You can locate the file by clicking the Change (Locate if file is missing) button and selecting 
the file path. 
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Error Loading Media File(s)
This dialog will appear if one or more files that you are trying to add or use within a project 
cannot be loaded correctly. 
There can be several reasons for a file failing to load.
The specified media files can no longer be found. 

A removable or network drive may no longer be available, or the project file may have been 
saved on another computer.

If you wish to move projects between several computers, you will need to backup your 
project. 
If any media cannot be found by the project, you will need to locate the media on your 

computer, and either add the media back into the project or restore the media to the 
directory that the project expects it to be found. 

The media files may not be valid. 
Images or video you are trying to load may either be corrupted, or in a format that 
PhotoStage does not yet recognize. 

If there is an unrecognized image or video format that you use regularly, please consider 
using Help -> Send Improvement Suggestion or Feedback to help us expand 
PhotoStage's functionality and make it even more useful for you. 

There may not be enough memory available to load the desired media.  
Some images or video may not be able to load if the dimensions of the media are extremely 
large.
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Shortcut Keys Reference
● F1 Open Help documentation 
● Ctrl+M Add Media 
● Ctrl+K  Add blank slide 
● Ctrl+A  Select all media files 
● Ctrl+Shift+A Select all slideshow slides 
● Ctrl+R  Reset selection 
● Ctrl+U  Fullscreen preview 
● Ctrl+N  Create new project 
● Ctrl+O Open existing project 
● Ctrl+S Save project 
● Ctrl+Shift+S  Save as project or video file 
● Ctrl+E Add selected file in media list area to Slideshow 
● Ctrl+D  Duplicate slide 
● Ctrl+X Cut slide 
● Ctrl+C  Copy slide 
● Ctrl+V Paste slide 
● F2 Rename media file 
● L Split the slide at the current position 
● Left  Go to previous slide 
● Right Go to next slide 
● Ctrl+Left  Step left 
● Ctrl+Right  Step right 
● Space Play slideshow 
● Home  Move cursor to start 
● End Move cursor to end (during playback: end - 3 seconds, when stopped: end) 
● Shift+End  Move cursor to end (during playback: end) 
● Shift+G  Set cursor position 
● Esc Cancel current operation 
● Ctrl+Z  Undo your last action 
● Ctrl+Y Redo your last action 
● Delete Remove item 
● F12 Save current frame as an image 
● Alt Show full menu 
● Alt+Enter Open selected media file details 
● Alt+F4 Exit PhotoStage 
Shortcut Keys in Adjust your slide  dialog: 
● F9 / Space Play 
● Esc / Space Stop 
● Home  Go to Start 
● End Go to End 
● (,) Set Start Time at the cursor 
● (.) Set End Time at the cursor 
● (+)  Zoom-in on the timeline 
● (-)  Zoom-out on the timeline 
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Adding Bookmarks
To add a bookmark to the timeline, right click on the timeline then click on Set Bookmark. 
To edit the name or the color of an existing bookmark, right click on the bookmark then click on 

. 
To remove an existing bookmark, right click on the bookmark then click on Remove Bookmark

These options allow you to highlight the important moments in your slideshow and make for 
easier navigation through it. 
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NCH Software Suite
This is a useful way to browse all the software available from NCH Software
You can see a set of products by type like Audio, Video and so on and view the product. From 
there you can try out the product and it will download and install it for you to trial. If you already 
have the product installed then you can click "Run It Now" and the program will be launched for 
you.

There is also a list of features for products in the category. Click on a feature, such as "Edit a 
Video File", to install a product with that ability.
Search  
Search our website for products matching any keywords you type. 
See more of our software  
Browse our website for more software. 
Subscribe to our newsletter 
You can subscribe to our newsletter for announcements of new releases and discounts. You 
can unsubscribe at any time. 
See the latest discounts for purchase  
See the latest discounts we are offering for purchasing our products. 
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Google Authorization Process on Windows XP 
and Vista
Extra steps are required to give PhotoStage authorization to upload to Google Drive and/or 
YouTube when running on Windows XP or Windows Vista: 
1. Click Authorize... in the Authorization dialog. 
2. In the web page that opens, sign in to your Google account, if required. 
3. Confirm that you authorize PhotoStage to access the requested features. 
4. Copy the Authorization Code  provided by Google and paste it in the Authorization 

confirm dialog in PhotoStage. 
5. Click Ready to confirm that authorization is complete. 
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Software License Terms
Our goal is for every user to have a successful experience with our software. We offer it to you 
on the basis that you accept our End User License Agreement (EULA).
This EULA limits our liability and is governed by an arbitration agreement and venue 
agreement. Please read below as these terms affect your rights.
1. The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. Installation 
of this software and any software bundled with or installed-on-demand from this software, 
including shortcuts and start menu folders, is licensed only in accordance with these terms. 
These copyrights do not apply to any creative work made by you, the user.

2. By installing, using or distributing the software you, on your own behalf and on behalf of your 
employer or principal, agree to these terms. If you do not agree to any of these terms, you may 
not use, copy, transmit, distribute, nor install this software - return it to the place of purchase 
within 14 days to receive a full refund.

3. This software, and all accompanying files, data and materials, are distributed "as is" and with 
no warranties of any kind, whether express or implied except as required by law. If you intend 
to rely on this software for critical purposes you must test it fully prior to using it, install 
redundant systems and assume any risk.

4. We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for all 
claims is limited to receiving a full refund for the amount you paid for the software.

5. You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You may not use this software if you 
do not regularly backup your computer, or do not have antivirus and firewall software installed 
on the computer, or keep sensitive data unencrypted on your computer. You agree to 
indemnify us from any claims relating to such use.

6. You may copy or distribute the installation file of this software in its complete unaltered form 
but you may not, under any circumstances, distribute any software registration code for any of 
our programs without written permission. In the event that you do distribute a software 
registration code, you will be liable to pay the full purchase price for each location where the 
unauthorized use occurs.

7. Use of data collected by the software is subject to the NCH Software Privacy Statement 
which allows automatic anonymized collection of usage statistics in limited circumstances.
8. Choice of Law. If you reside in the United States, your relationship is with NCH Software, 
Inc, a United States company, and this agreement is governed by the laws and courts of 
Colorado. If you reside anywhere in the world outside of the United States, your relationship is 
with NCH Software Pty Ltd, an Australian company, and this agreement is governed by the 
laws and courts of the Australian Capital Territory. Such courts have continuing and exclusive 
jurisdiction over any dispute between you and us, regardless of the nature of the dispute.

9. U.S. Customers Only: Arbitration Agreement and Class Action Waiver: PLEASE READ THIS 
CAREFULLY. IT MAY AFFECT YOUR RIGHTS.
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If you reside in the United States, NCH Software and you agree to arbitrate all disputes and 
claims between us. This agreement to arbitrate is intended to be broadly interpreted. 
References to "NCH" "you," and "us" include our respective subsidiaries, affiliates, agents, 
employees, predecessors in interest, successors, and assigns. This arbitration agreement 
does not preclude you from bringing issues to the attention of U.S. federal, state, or local 
agencies. Such agencies can, if the law allows, seek relief against us on your behalf. This 
Agreement evidences a transaction in interstate commerce, and thus the Federal Arbitration 
Act governs the interpretation and enforcement of this provision. This arbitration provision shall 
survive termination of this Agreement.

A party who intends to seek arbitration must first send to the other, by certified mail, a written 
Notice of Dispute ("Notice"). The Notice to NCH should be addressed to:
Legal Department
NCH Software, Inc.
6120 Greenwood Plaza Blvd, Ste 120
Greenwood Village CO, 80111
USA 
("Notice Address"). The Notice must (a) describe the nature and basis of the claim or dispute; 
and (b) set forth the specific relief sought ("Demand"). If NCH and you do not reach an 
agreement to resolve the claim within 30 days after the Notice is received, you or NCH may 
commence an arbitration proceeding. The amount of any settlement offer made by NCH or you 
shall not be disclosed to the arbitrator.

A. The arbitration will be governed by the Commercial Arbitration Rules and the Supplementary 
Procedures for Consumer Related Disputes (collectively, "AAA Rules") of the American 
Arbitration Association ("AAA"), as modified by this Agreement, and will be administered by the 
AAA. The AAA Rules are available online at adr.org, by calling the AAA at 1-800-778-7879, or 
by writing to the Notice Address. The arbitrator is bound by the terms of this Agreement. All 
issues are for the arbitrator to decide, including issues relating to the scope and enforceability 
of the arbitration provision. Unless NCH and you agree otherwise, any arbitration hearings will 
take place in Greenwood Village Colorado. If your claim is for $10,000 or less, we agree that 
you may choose whether the arbitration will be conducted solely on the basis of documents 
submitted to the arbitrator, through a telephonic hearing, or by an in-person hearing as 
established by the AAA Rules. If your claim exceeds $10,000, the right to a hearing will be 
determined by the AAA Rules. Regardless of the manner in which the arbitration is conducted, 
the arbitrator shall issue a reasoned written decision. NCH will pay all AAA filing, 
administration, and arbitrator fees for any arbitration initiated in accordance with the notice 
requirements above. If, however, the arbitrator finds that either the substance of your claim or 
the relief sought in the Demand is frivolous or brought for an improper purpose then the 
payment of all such fees will be governed by the AAA Rules. In such case, you agree to 
reimburse NCH for all monies previously disbursed by it that are otherwise your obligation to 
pay under the AAA Rules. In addition, if you initiate an arbitration in which you seek more than 
$75,000 in damages, the payment of these fees will be governed by the AAA rules.

B. The arbitrator may award declaratory or injunctive relief only in favor of the individual party 
seeking relief and only to the extent necessary to provide relief warranted by that party's 
individual claim. YOU AND NCH AGREE THAT EACH MAY BRING CLAIMS AGAINST THE 
OTHER ONLY IN YOUR OR ITS INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR 
CLASS MEMBER IN ANY PURPORTED CLASS OR REPRESENTATIVE PROCEEDING. 
Further, unless both you and NCH agree otherwise, the arbitrator may not consolidate more 
than one person's claims, and may not otherwise preside over any form of a representative or 
class proceeding. If this specific provision is found to be unenforceable, then the entirety of this 
arbitration provision shall be null and void.
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C. Notwithstanding any provision in this Agreement to the contrary, we agree that if NCH 
makes any future change to this arbitration provision (other than a change to the Notice 
Address) you may reject any such change by sending us written notice within 30 days of the 
change to the Arbitration Notice Address provided above. By rejecting any future change, you 
are agreeing that you will arbitrate any dispute between us in accordance with the language of 
this provision.

D. To opt out of this Arbitration Agreement and class action waiver send an Opt Out notice to 
the Notice Address stating "I am electing to opt out of the Arbitration Agreement and class 
action waiver contained in the Legal Terms applicable to my purchase of an NCH product." 
Your Opt Out Notice must include the date and proof of purchase. The Opt Out Notice must be 
postmarked no later than thirty (30) days after the date of purchase. A separate Opt Out Notice 
must be sent for each product purchased.
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Working with Audio - Overlapping Sound Clips
When adding sound files to the audio track or rearranging sound files, the Overlapping 
Sound Clips dialog may appear. This means that the position you have placed the sound clip 
overlaps with another sound clip on the same track. 
You can either:
● Press cancel and move the sound clip to a different track
● Select an option from the list and press OK: 

1. Cut the clip to fit between clips  Choosing this option will trim your sound clip to fit in 
the gap you have selected. This option may be unavailable. 

2. Push clips on the timeline right Choosing this option will push all clips on the track 
further forwards until the clip you have added fits. 
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Working with Audio - Audio Ducking
Use this feature to apply an auto duck effect to clips that overlap the selected clip. 
PhotoStage detects the volume of the clip and applies volume reduction to clips in the 
background (overlapping clip). It is helpful if you want to lower the music background when a 
vocal is the main focus and then raise the music background when the vocal is silent. 

How to Use 
At least 2 audio tracks occupied on the sequence are required to apply the auto ducking 
effect. 
To apply audio auto ducking effect to an audio clip on the sequence, right-click on it and 
select Suppress Volume of Soundtrack Behind this Sound Clip . 
The background clips will be ducked based on the detected volume of the applied audio 
clip. 
Audio Ducking Settings  
To configure the Audio Ducking settings, go to Options->Audio tab. 

Ducking Attenuation: The amount of attenuation applied when ducking 
Ducking fade in length: The length of time over which the ducking is activated 
Ducking fade out length:  The length of time over which the ducking is released 
Ducking Threshold:  Ducking is activated when the volume of main sound hits this level 
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Working with Audio - Sound Effects
This help topic describes the audio effects that can be applied to any audio clip. The effects 
are found by opening the Effect Chain dialog. You can open the effects chain dialog by right 
clicking an audio clip and selecting Track Effects... Alternatively you can also open the dialog 
by selecting an audio clip and clicking Audio -> Track Effects...  in the top menu. 

Amplify 
Compressor 
Echo 
Reverb 
Flanger 
Chorus 
Distortion 
High-pass Filter 
Presets  

Some effects come with a series of options known as Presets . The idea behind presets is to 
save you having to fiddle around with the numbers, which is great if the numbers don't mean a 
lot to you. Instead, you can just browse the preset list and select the option which best 
describes the effect you are trying to achieve. 
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Effects - Amplify
Amplify
To 'amplify' is to increase the loudness or volume of the selected region. To make a part of the 
recording softer or louder, select it and then use the menu Effects -> Amplify. The volume is 
entered in percent (100 being no change, 50 being -6dB softer or 200 being +6dB louder).
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Effects - Compressor
Dynamic Range Compressor
A dynamic range compressor limits the volume levels of a sound recording so that it stays 
within a certain loudness range.

An example of where it is used is in TV broadcasting, where it ensures that the volume levels 
of ads are perceived as being louder than the television program itself (without any change in 
the actual broadcast volume).

It also has a use for recording audio from one medium to another, where the two mediums are 
not capable of handling the same range of volume levels (e.g. A CD can handle a much 
greater range than a cassette tape).

The Dynamic Range Compressor dialog has two tabs: "Simple" and "Graphic". Changing 
settings on the Simple tab will also change the graph on the Graphic tab, but not vice versa as 
the graph allows more control. There is also an "Advanced Compressor Settings" dialog for 
adjusting more advanced features.

The Simple Tab
The "Simple" tab of the Dynamic Range Compressor dialog contains settings called "Limiter", 
"Compressor", and "Noise Gate". While these sound like three different things, they are more 
accurately viewed as three different ways of using the dynamic range compressor.

The "Limiter" defines the maximum decibel level that the sound recording will be allowed to rise 
up to. So if, for example, the Limiter Threshold was set to -2dB, then you would never hear the 
volume level of the recording get louder than -2dB. Any signal over the limiter threshold would 
be clipped, which would probably cause distortion. Note that setting the Limiter Threshold to 
0dB effectively turns the limiter off, because 0dB represents the loudest signal possible in a 
digital recording.

The "Compressor" reduces the volume of any sound which exceeds its "Threshold" setting. 
When a signal exceeds the threshold, the compressor gradually attenuates the sound to bring 
it down below the dB level, and does it in such a way that the listener will not be aware the 
attenuation is occurring. The compressor differs from the limiter in that the compressor does 
allow sounds to go above its threshold (for a short time), whereas the limiter does not.

The "Ratio" setting defines the ratio of the reduction in volume of sounds which exceed the 
compressor threshold. For example, if the ratio is 4:1 and the volume exceeds the threshold by 
4dB, then the volume will be reduced to only exceed the threshold by 1dB. Note that a ratio of 
1:1 means that there will be no change in volume; it effectively turns the compressor off.

The "Noise Gate" works similarly to the Compressor, except that is reduces the volume of 
sound below its Threshold. This can be useful for reducing or removing softer background 
noise from a recording.

You will find that the maximum Compressor Threshold you can set is the same as the current 
Limiter Threshold value. This basically means that, in any situation, the sound will start to 
attenuate at the Compressor Threshold, but will never be heard louder than the Limiter 
Threshold. Similarly, the maximum Noise Gate Threshold you can set is the same as the 
current Compressor Threshold.

The Graphic Tab
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The "Graphic" tab of the Dynamic Range Compressor dialog shows a graph which represents 
the relationship between input and output volumes. The horizontal axis shows input volumes in 
dB from -60dB to 0dB. The vertical axis shows output volumes on the same scale. The graph 
will be changed by changes to settings on the Simple tab, but changes to the graph will not be 
reflected on the Simple tab, because it is possible to represent a wider variety of settings on 
the graph than is possible in the controls on the Simple tab. When the dynamic range 
compressor is applied it will use the settings from the Graphic tab.

To change the graph, click and drag the black vertex markers, or click anywhere else to create 
a new vertex. To remove a vertex, right-click on it.

Advanced Compressor Settings
Clicking on the "Advanced" button in the Dynamic Range Compressor dialog will open the 
Advanced Compressor Settings dialog. In it are controls for the following properties of the 
compressor: 

   -Input Level Sensing - Peak or RMS:
   -This controls how the compressor determines the audio level. "Peak" sensing looks at the 
highest point in the window of audio which it examines. It will almost always give a higher 
reading than "RMS" sensing, which uses an average, or Root Mean Square of the window to 
determine the audio level. RMS sensing more closely corresponds to the audio level which a 
human listener would perceive.

   -Compressor Response:
   -
   -Attack:
   -The time (between 0 and 1000 milliseconds) that it will take to apply the gain adjustment. 
The total gain adjustment required will be gradually introduced over this period.
   -Release:
   -The time (between 0 and 5000 milliseconds) that it will take to remove the gain adjustment 
once gain adjustment is no longer needed. This is the opposite of attack.
   -WindowLength:
   -The length (between 10 and 50 milliseconds) of the window to use when calculating the 
current audio level. A shorter window responds to level changes more rapidly, but anything 
less than 50ms will start to respond inconsistently to bass, since 50ms (20Hz) is the 
wavelength of the lowest human-audible sound.

   -LookAhead:
   -How far ahead (between 0 and 100 milliseconds) to look at the input level when determining 
the output gain adjustment. This can cause the compressor to start responding to a change in 
volume before it happens. If this value is the same as the attack time, then the full gain 
adjustment could be made by the time the louder signal is reached.

   -Side-Chain Equalizer:
   -This determines how strongly the compressor should weight different audio frequencies 
when determining the input level. For example, to compress only when there is a loud bass 
sound, turn the Bass level up and/or reduce the MidRange and High levels.

   -Auto Makeup Gain:
   -When this option is selected compressor automatically makes up the gain lost in the 
compression process. Select this option if you want to amplify the compressor output to the 
original audio level. 

Dynamic Range Compressor Presets
The following presets have been defined for your convenience. A preset will change the 
settings of the dynamic range compressor, after which you can make further adjustments if 
necessary. The presets are:    -Default:
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   -Pressing the "Default" button will cause the compressor to have no effect. It sets the output 
levels to be exactly the same as the input levels, and also resets the advanced settings to their 
defaults.

   -Fast Compressor:
   -This compression preset will cause any spikes over -20dB to be rapidly reduced, but will not 
cause distortion. It uses peak input level sensing and a fast attack, which will reduce the 
volume of transient sounds (such as a snare drum hit), but may also change their characteristic 
sound. Compare this with the Smooth Compressor preset below.

   -Smooth Compressor:
   -This preset reduces the volume more gradually when the signal climbs above -20dB. The 
slow attack time will mean that transients (such as snare drum hits) will not be changed, or if 
they are then they will be uniformly reduced, thus their characteristic sound will not be 
significantly altered.

   -Heavy Compressor:
   -This preset uses a lot of compression whenever the average volume climbs over -30dB, 
resulting in a very uniform dynamic range. This can be useful for making the quieter parts of 
music with a large dynamic range (such as classical music) easier to hear in noisier 
environments, such as in a car or a restaurant.

   -Hard Limit:
   -This preset does not allow any sounds to exceed -12dB. This may cause distortion due to 
clipping in some tracks.
   -Soft Limit:
   -This limit allows short spikes over -6dB, but will prevent longer durations of audio over this 
threshold.
   -Noise Gate:
   -This will remove soft sounds from a track. This can be useful for removing the crackle of a 
record player during silences, or background noises in a dictation.
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Effects - Echo
Echo
An echo is a repeat of the sound after a short time (usually 400 - 1000ms). It sounds a bit like 
the person is in a large stadium or is shouting between two mountains.

To add echo select the region and use the menu Effects -> Echo then specify the duration and 
amplitude of the echo. The duration is the length of time after which the sound repeats - 
usually this is between 400 and 1000ms. The amplitude can be between 1 - 99% (99 being a 
very loud echo).
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Effects - Pitch Shifter
Pitch Shifter
Pitch Shifter is a sound effect that raises or lowers the pitch of audio signals. You can adjust 
pitch shifter speed by dragging the slider in the settings.
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Effects - Reverb
Reverb
Reverb is many small reflections of the sound that come after a set time. It usually occurs 
when someone is speaking in a room, hall, etc. More reverb is called wet, no reverb is called 
dry. When you select the reverb effect, you will see a dialog with two tabs.

Simple 
The first tab of the reverb effect allows you to adjust the reverb level and time. The reverb 
level is the amplitude - 99 is very wet, 0 is dry. The time can be between 100 and 800ms - 
200ms sounds like a small room or 800ms a large hall. If you add too much reverb it can 
sound like the person is in a pipe or in the bathroom.

The Simple tab also includes preset options to choose from, depending on how large the 
space being simulated is. Click the play button at the bottom of the tab to preview the reverb 
effect on your audio.

Room Design 
The second tab of the reverb effect allows you to specify the dimensions of a room, the 
position of the source and listener, and the room absorption with preset options for the 
materials that make up the walls, floor and ceiling of the room. Click the play button at the 
bottom of the tab to preview the reverb settings on your audio.
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Effects - Flanger
Flanger
A Flanger sound effect is similar to the phaser except that the delay is slowly modulated over 
time. You specify the starting delay time (default 5ms), the frequency of modulation in times 
per second (default 0.5Hz which is 2 seconds) the depth of modulation (default 70%) and the 
wet dry gain (100% for wet, 0% for dry, default 60%).
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Effects - Chorus
Chorus
The chorus sound effect is used to make one voice or one instrument sound like 3 voices or 
instruments by playing the original with variably delayed and slightly pitch changed copies of 
the original.

Note: Chorus is a very useful way to make a mono source sound more stereo. You should 
convert your file to stereo first before using Chorus.
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Effects - Distortion
Distortion
While normally we do everything to reduce distortion, sometimes you want to add it. It is 
popular for use with guitars. The distortion is measured between 0.0 (off) and 1.0 (clipping). 
You also specify the level where it kicks in in dB.

For a more consistent sound, you should apply Dynamic Range Compression first before you 
add distortion.
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Audio Cleanup - High-Pass Filter
High-Pass Filter
A high-pass filter (sometimes called a low cut filter) removes all low frequencies below a 
specified Hz. This is useful if you want to make your recording sound 'clearer' or less 'muddy'. 
It is very usual to use a high-pass filter of about 250Hz on all voice recordings to improve 
intelligibility.
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Audio Cleanup - Low-Pass Filter
Low-Pass Filter
A low-pass filter removes all high frequencies above a specified Hz. This is useful if you want 
to make your recording sound 'clearer'. It is very usual to use a low-pass filter of about 1600Hz 
on all voice recordings to improve intelligibility.

54



Finalize a Project - Saving a Video to Computer
Saving a Video to Computer 

Export to Video File  or Export to Portable Video option to create a stand alone 
video file in your choice of format. You can then transfer your video file to a portable device, 
upload to the internet or use it with other software. 
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Finalize a Project - Burning a Video
Burning a Video 
The kinds of media to which you can Burn your project are DVDs. 
You are also able to burn your project to this media in two different ways. 
● Video Discs 

The project is exported in the format by which consumer devices will be able to play your 
video. 
That is, as a normal DVD. 

● Data Discs 
The project will be exported as a file. Which will appear on the DVD you are burning it to. 
Unlike a normal video disc, some consumer devices may not be able to play your video, or 
you may need to navigate device specific menus to find, and play them. 
This is similar to inserting a USB device into your media player, if it supports that feature. 

You can begin the Burning process by selecting DVD  options from one of the following 
locations: 
● From the Home  Toolbar. Click the Export  drop down button. 
● From the Export  tab on the Toolbar. Click the DVD Disc drop down button 
● From the Export  menu on the Main Menu. 
After making your selections on the Video Output Setup dialog, click Create, and follow any 
onscreen prompts. 
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Finalize a Project - Save as Image Sequence
Save as Image Sequence 
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Finalize a Project - Dropbox
Dropbox 
You can open the Dropbox export dialog via one of the following methods: 
● From the Home  Toolbar. Click the Export  drop down button. Select the Dropbox option. 
● From the Export  Toolbar. Select the Dropbox button. 
● From the Export  menu on the Main Menu. Select the Dropbox option. 
Once reaching the Dropbox export dialog, you can choose assorted settings that will be 
applied to the exported project. After making your selections click on Link to Dropbox..., this 
will open the Dropbox Authorization dialog. 
Once the Authorization dialog appears, login to your Dropbox Account, and follow the prompts 
to allow the application to access your online profile. 
After authorization is complete, you can click the Create button to commence the export and 
upload process. 
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Finalize a Project - Flickr
Flickr 
You can open the Flickr export dialog via one of the following methods: 
● From the Home  Toolbar. Click the Export  drop down button. Select the Flickr option. 
● From the Export  Toolbar. Select the Flickr button. 
● From the Export  menu on the Main Menu. Select the Flickr option. 
Once reaching the Flickr export dialog, you can choose assorted settings that will be applied to 
the exported project. 
After making your selections click on Create, to being the export and upload process. 
If required, the Flickr Authorization  dialog will appear and your web browser will open, 
allowing you to log in to the service. 
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Finalize a Project - Google Drive
Google Drive  
You can open the Google Drive export dialog via one of the following methods: 
● From the Home  Toolbar. Click the Export  drop down button. Select the Google Drive  

option. 
● From the Export  Toolbar. Select the Google Drive  button. 
● From the Export  menu on the Main Menu. Select the Google Drive  option. 
Once reaching the Google Drive export dialog, you can choose assorted settings that will be 
applied to the exported project. After making your selections click on Link to Google Drive... , 
this will open the Google Drive Authentication  dialog. 
Once the Authentication dialog appears, login to your Google Account if required, and follow 
the prompts to allow the application to access your online profile. 
After authentication is complete, you can click the Create button to commence the export and 
upload process. 
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Finalize a Project - Microsoft OneDrive
Microsoft OneDrive  
You can open the OneDrive export dialog via one of the following methods: 
● From the Home  Toolbar. Click the Export  drop down button. Select the OneDrive  option. 
● From the Export  Toolbar. Select the OneDrive  button. 
● From the Export  menu on the Main Menu. Select the OneDrive  option. 
Once reaching the OneDrive export dialog, you can choose assorted settings that will be 
applied to the exported project. After making your selections click on Link to Microsoft 
OneDrive..., this will open the Microsoft Authentication dialog. 
Once the Authentication dialog appears, login to your Microsoft Account if required, and follow 
the prompts to allow the application to access your online profile. 
After authentication is complete, you can click the Create button to commence the export and 
upload process. 
If the upload process to OneDrive fails, please check Troubleshooting OneDrive. 
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Finalize a Project - Vimeo
Vimeo 
You can open the Vimeo export dialog via one of the following methods: 
● From the Home  Toolbar. Click the Export  drop down button. Select the Vimeo option. 
● From the Export  Toolbar. Select the Vimeo button. 
● From the Export  menu on the Main Menu. Select the Vimeo option. 
Once reaching the Vimeo export dialog, you can choose assorted settings that will be applied 
to the exported project. 
After making your selections click on Create to begin the export and upload process. 
If required, the Vimeo Authorization dialog will appear and your web browser will open, 
allowing you to log in to the service. 
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Finalize a Project - Youtube
YouTube  
You can open the YouTube export dialog via one of the following methods: 
● From the Home Toolbar. Click the Export  drop down button. Select the YouTube  option. 
● From the Export  Toolbar. Select the YouTube  button. 
● From the Export  menu on the Main Menu. Select the YouTube  option. 
Once reaching the YouTube export dialog, you can choose assorted settings that will be 
applied to the exported project. 
After making your selections click on Create, to being the export and upload process. 
If required the YouTube Authorization dialog will appear. Login to your YouTube Account, 
and follow the prompts to allow the application to access your online profile. 
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Finalize a Project - HTML5 for Website
Exporting as HTML5 for Website allows you to create a slideshow using clips from your 
PhotoStage project and integrate it to your website. 
The website source code (HTML, CSS, Javascript) and its image dependencies will be created 
in the selected destination. Currently, only images with its applied effects (except animations) 
and crossfade transition are supported. 

Export Options 
The following options are available in the export dialog: 

● Save to:  Directory to where the the website files will be saved. The source files (html - 
slideshow.html, css - slideshow_style.css and javascript - slideshow_script.js) will be 
saved in the root directory while the html image dependencies will be saved inside a 
folder named 'html'. 

● Resolution: Resolution of the output slideshow images. Choose Auto Match Content  
to select the smallest resolution that will fit all the images. 

● Output Options: 
● Auto play slideshow on page load: Automatically play the slideshow on page 

load and do not show the play button. 
● Automatically loop slideshow: Make the slideshow automatically repeat during 

playback 
● Include fullscreen button: Adds a fullscreen button at the bottom right of the 

slideshow used to show the slideshow in fullscreen. 
● Include navigation bar beneath the slideshow: Adds a navigation bar to seek 

between slides. 
● Include NCH watermark:  Adds the NCH watermark at the bottom-center of the 

slideshow. Removing the watermark is a paid feature and can be done by 
purchasing PhotoStage. 

Integration to Website  
It is very easy to add the slideshow whether to a new website or to an existing one. Exporting 
to HTML5 for Website provides a sample html file (index.html) that can be used to start 
creation of your website with the slideshow. It contains an <iframe> tag with slideshow.html as 
the source. For easy layouting, the <iframe> follows the size of its parent container (i.e. <div>). 
For your website slideshow to properly display, copy all contents of your "Save To" directory to 
your hosting site (e.g. a web server). 

To include the slideshow to your existing website, copy and paste the following code to your 
html file. It uses the similar <iframe> tag inside a parent container that defines the size of the 
slideshow. For this, you will need to copy the "Save To" directory contents to your host except 
index.html. The <iframe> will be used to include the slideshow to your website. You can adjust 
the width and height of the <div> as needed. 

<div style="width:640px; height:690px; margin:auto"> 
   <!-- Width and height of the iframe is a percentage of the parent --> 
   <!-- Setting margin to "auto" centers the iframe horizontally inside the div --> 
   <!-- Setting border-style to "none" removes the default iframe border --> 
   <iframe src="slideshow.html" style="width:100%; height:100%; margin:auto; 
border-style:none"> 
   </iframe> 
</div> 
The slideshow is default center aligned to its upper level container (e.g. another <div> or 

<body>). To modify this, do the following in the <div> containing the <iframe>: 
Change margin:auto to float:left for left align and to float:right for right align. 
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NCH Sound Library - NCH Sound Library
The NCH Sound Library  is a collection of thousands of royalty-free sound effects that can be 
added to your project. 
Once you have opened the library, you'll see the following:

Folder Tree 
On the left hand side, each folder represents a category of sounds. Expand a folder to 
either see its subfolders or a list of sounds it contains. 
Sound List 
On the right hand side, all the sounds in the currently selected category are listed. This will 
be empty until a category is selected. 
Preview Sound  
Select a sound in the list then click the Play button to hear it. When you have finished, click 

. 
Download 
Select a sound in the list then click the Download button to download the sound (if it hasn't 
already been downloaded). 
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Screen References - Flickr Authorization
You must complete Flickr authorization before any videos can be uploaded to your Flickr 
account. 

Click 'Export' and select 'Flickr'. 
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● In the web page that opens, sign in to Flickr.
● Click OK, I'LL AUTHORIZE IT to confirm that you allow PhotoStage to upload videos to 

your Flickr account.
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Screen References - Color Picker Dialog
Color Picker Dialog  
The color picker is divided into multiple parts, with several ways available to choose a color: 
Visually Adjusting Color  

The top half of the dialog consists of 2 colored boxes, one that lets you pick any point in a 
256 x 256 square and the other that works as a long slider. Which colors are displayed in 
these two boxes depends on which radio button is selected (see below), but in all cases the 
position of the slider will change the colors available in the square box. Which ever point is 
selected in that square box is the selected color. 

Adjusting by RGB or HSV 
Underneath the square colored box, there is a series of 6 options (1 each for hue, 
saturation, value, red, green, and blue) that each contains a radio button, a slider, and an 
up-down number control. If one of the 3 HSV radio buttons is selected, that value will be 
represented by the visual slider (see above) while the other two values will be the axes of 
the square color box. The controls work the same way if one of the RGB radio buttons is 
selected. You can also adjust these values with the sliders provided next to the labels, as 
well as the up/down controls next to the sliders. Any adjustment of these values will update 
the visual controls, and any adjustment of those visual controls will update these values. 

Selected Color 
The selected color is displayed to the right of the RGB and HSV controls. The box is split 
diagonally, with the upper left section labeled New (the color you are creating), and the 
bottom right section labeled Current (the color that already exists, and will continue to be 
selected if you Cancel the dialog). Beneath that is the Hex Value of the selected color (you 
can also enter any valid hex value there to update the selected color). There is an 
eyedropper button to the right of the selected color that will allow you to set the selected 
color by sampling anywhere on the desktop. 

User-defined Color Palette  
At the bottom of the dialog you will find a series of 12 colored rectangles alongside a button 
titled Set to Swatch. These comprise the user-defined color palette, and allow you create 
and save (these will persist even when PhotoStage is closed) your own custom colors. To 
set a swatch's color, first select that swatch by clicking it. Then choose your desired color, 
and finally click the Set to Swatch button. You can then load any of the saved colors by 
simply clicking on that swatch. 
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Screen References - Burn Audio CD
The following settings can be altered to affect the burning process. The ones noted as default 
are initially selected. All settings are remembered so you do not need to change them between 
uses of Express Burn

Burn Using Internal Support (default)/Burn using Windows Media Player 
In all cases we would recommend using the internal support (the default) and only use 
Windows Media Player if you experience problems Windows Media Player can be used to burn 
the CD/DVD for users of Windows XP only.

Burner Drive  
Choose the drive you wish to burn to.
For Data CD/DVDs you can also select 'Image File'. This allows you to create and ISO file (eg 
image.ISO) on your harddrive. This can be later burned using the Advanced option Write ISO 
image. This feature is only available in Express Burn Plus.

Write Speed  
Choose the write speed you desire. Only valid speeds for the drive and media will be displayed.
Copies  
This is the number of copies of the CD/DVD to burn (defaults to 1).
Use Overburning  
If this is selected Express Burn will attempt to write all the files you have specified even if this is 
longer than the rated size of the CD media. If the burn fails then you should write fewer files.
Erase Rewritables 
If you are burning to a rewritable disc (CD-RW, DVD-RW, DVD+RW, BD-RE) the disc will be 
automatically erased if you check this option. You may erase a disc using the Burner menu 
option and the selection Erase Rewritable Disc.

Use default track pause 
Burn Session At Once to customize pause  
Track Pause 
By default an audio CD has a pause of 2 seconds between tracks. Select 'Use default track 
pause' to use this default pause. If you wish another time, even a value of zero for no pause 
then select 'Burn Session At Once to customize pause'. Here you should also change the value 
in 'Track Pause' to the desired amount.

Please note some older drivers do not support customizing the pause and you must use 'Use 
default track pause'. The burn will fail in this case with an error about setting the write 
parameters.

If you customize the time Express Burn will perform Session At Once burning and it will decode 
the audio before burning. This will create a large temporary file on you PC of up to 700Mb. 
Please be aware of this is you choose to use this option.

Finalize 
For audio discs written Track At Once (ie without customizing the track pause) you can choose 
to not finalize a disc. You can then add additional tracks at a later time. When you have 
finished then select the finalize option. Please note some stand-alone players cannot play 
discs that have not been finalized.

Make Disc Bootable (Data Discs only) 
This will create a bootable disc, but you must provide an image of the boot sectors as 
copywrite prevents us supplying them. This need to be an image of up to 16 sectors from the 
start of a bootable disc. The file should be an ISO image of 16 2048 byte sectors.
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Screen References - Please Select the Drive to Use
On this page you select the burner you wish to use. This is normally optional as Express Burn 
will detect when you insert a disc in a drive and automatically select that drive for burning.
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Screen References - Clip Volume
The Clip Volume dialog is where you can adjust the volume of the selected clip. To open this 
dialog, right click on the audio track for the selected clip and select Adjust clip volume from the 
context menu.

Use the volume control slider to increase or decrease the volume. Check the Mute clip 
checkbox if you don’t want to hear the audio for this clip.
Click the OK button to save any volume adjustments to the clip.
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Screen References - Custom Resolution
This dialog allows you to set up the resolution for your video during saving. To set a custom 
resolution, click the Save button on the toolbar and select the Disc: Make Data Disc, 
Computer/Data, Portable Device, Image Sequence, or Stereoscopic 3D options. From the 
Resolution drop menu, select Custom.

In the Custom Resolution dialog that opens, input the width and height in pixels and click OK.
If Keep aspect ratio checkbox is available, you can check it to retain the same aspect ratio 
when changing the width or height. 
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Screen References - Custom Resolution 
(360-Degree Video)
This dialog allows you to set up the resolution for your 360-degree video during saving. To set 
a custom resolution, click the Save button on the toolbar and select the 360 Video File option. 
From the Resolution drop menu, select Custom.

In the Custom Resolution dialog that opens, input the width and height in pixels and click OK.
The width must be exactly double the height for 360-degree videos.
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Screen References - Custom Frame Rate
This dialog allows you to set up the frame rate (number of frames per second) for your video. 
To set a custom frame rate, click the Save button on the toolbar and select either of the Disc: 
Make Data Disc, Computer/Data, Portable Device, or Stereoscopic 3D options. From the 
Frame Rate drop menu, select Custom.

In the Custom Frame Rate dialog that opens, input the frame rate and click OK.
The default frame rate is Variable Frame Rate (VFR)  but the dialog allows the user to select C
onstant Frame Rate (CFR)  by selecting the Constant frame rate checkbox.
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Screen References - Detected Format
This dialog shows you the detected format of the video sequence during the saving process. 
To detect the format of your video, click the Export Video button on the Home tab bar and 
select either of the following options: Video File, 3D Video File, Portable Video, Lossless 
Video, DVD Movie Disc, DVD Data Disc, Image Sequence, YouTube, Flickr, Dropbox, Google 
Drive, OneDrive, or Vimeo.

Click the Detect button next to the Preset field. Detect will adjust the video output resolution 
format based on your monitor screen size.
If you want to use a different format you can select the format from the Preset drop-down list.
Click OK to use the selected format as the output format.
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Screen References - DVD Bitrate Settings
This dialog allows you to specify bitrate for your DVD video. To open this dialog, click the Save 
icon in the toolbar and select the Disc save option and click the Make DVD Movie option. Click 
the Advanced button to open the DVD Bitrate Settings dialog.

The default option is to calculate the bitrate automatically. To set the bitrate manually, select 
the manual option and adjust the video and audio bitrates.
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Screen References - Disc Menu Creator
This tab allows you to select the template you wish to use for your menus. The template is 
previewed in the large area to the right, with some descriptive text below. 
Until you click 'Save Menu' no actual changes will take place for the movies menu. 
Check for New Templates 
Check if any new templates are available for use in creating a menu. This will require an 
internet connection to do an online check.
Title:
This is the caption that will appear at the top of the menu.
Subtitle:
This is a second caption that appears at the top of the menu.
Text Alignment:
There are 3 horizontal alignment options for the title and the subtitle: left, center and right.
Menu Preview:
The Prev/Next buttons allow you to select between the possible menus when a 'List' type of 
template exceeds one page
Background Image Widescreen Fit
Select the aspect ratio mode for the menu’s background image.

● None: The background image will maintain its current aspect ratio regardless of the 
video output.

● Crop: The background image will be cropped to match the aspect ratio of the video 
output. Parts of your background image may be cut off if the aspect ratio does not 
match.

● Letterbox: A black background will display behind the image to create the correct aspect 
ratio to match the video output.

● Stretch: The background image will be stretched horizontally or vertically to match the 
aspect ratio of the video output.

Select custom image for this template...
This button allows you the change the background image that appears on the menu. 
Supported image formats are jpg/jpeg/jpe, png, gif.

78



Screen References - Select Templates
This window allows you to select templates that can be downloaded and installed. Checkmark 
the templates to be installed and click the Download button when finished. The 'Select All' 
button will select/un-select all templates. 
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Screen References - Auto Split Settings
Split File into Multiple Smaller Files  
The Auto Split Settings  dialog provides options to split your video to multiple smaller files for 
emailing. If the total size of your video file exceeds the Split File Size (in MB), the file will be 
split into multiple parts which each part having a maximum size given by the Split File Size. 
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Screen References - Loop Settings
Loop Video #N Times 
This option allows to loop the video based on Loop Count and add a delay per loop based on 

 (in seconds). The Loop Settings dialog shows the resulting video file length after 
applying the loop settings. 
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Screen References - GIF Encoding Settings
Looping
Select this to get your GIF repeat itself endlessly.
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Screen References - Select Stream
Select an audio stream Audio Stream: 
Select an audio stream from the file
Don't ask me again 
Suppress the popup dialog to select audio stream
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Screen References - Enter Position
Changing the timeline position  By pressing Shift+G on an appropriate window the current 
position of the timeline can be adjusted to any position entered into either the 'Enter New 
Sequence Position' or 'Enter new Media Preview position' dialogs. Enter a new position within 
the duration of the timeline and click OK to go to that position.

Editing a slide duration 
From the 'Adjust your slide' dialog while adjusting images, pressing Shift+G will allow you to 
modify the slide duration. Enter a new duration for your slide and click Apply  to save the 
change.
Modifying In and Out Points 
From the 'Adjust your slide' dialog while adjusting videos, clicking either the 'In Point:' or 'Out 
Point:' field controls will open the 'Enter New In Point dialog' or 'Enter New Out Point dialog' 
respectively. Once either of these dialogs is open, enter a new in or out point into the field and 
click Apply  to save the change.
Note that this method of editing slide lengths is best when precise lengths have been 
predetermined. If you prefer to line your in and out points up to visual cues on the slide, use 
the slide navigation buttons to cue up the precise moment you would like to change the in or 
out point to, then use the red and blue flags to set each point to the desired position.
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Screen References - Select new duration
The Select New Duration dialog allows you to change the duration of a slide in the sequence 
while in the Sequence Style of Storyboard. Click the ruler button of any slide on the slideshow 
to open the Select New Duration dialog.

To change the duration in the dialog, enter a new duration in seconds into the field, then click 
the OK button to save. If a shorter duration has been entered, the time will be taken off the end 
of the slide. If a longer duration has been entered, any time remaining after the slide's current 
out point will be added back on, up to the total duration of the slide. A slide cannot be made 
longer than its original length using this method.

Note that this method of editing slide lengths is best when precise lengths have been 
predetermined. If you prefer to line your in and out points up to visual cues on the slide, use 
the slide navigation buttons in the Selected slide Preview area to cue up the precise moment of 
the in or out point, then use the red and blue flags to mark the in or out point.
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Screen References - Adjust Margins
The margin is the gap between the overlay and the edge of the video. Enter the margin size as 
a percentage of total video width (horizontal margin) or height (vertical margin), then press Ok. 
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Screen References - Options ~ General
The General tab of the Preferences is where you set up cache parameters and adjust some 
settings for slides.
Cache 
● Default cache folder - Specify a folder where you want to store cached data.
● Maximum allowed cache size in MB - Specify the maximum allowed hard drive space to be 

used by the cache.
● Remove cache files on exit - All cache files will be removed on exit. This restores occupied 

hard drive space but the cache will need to be rebuilt next time you use it.
● Clear cache - Click this button to clear all unused cache files.
Slides 
● Default still image duration - Specify the duration, in seconds, to use for images when they 

are first added to the project.
● Attach short sound clips to video - Select this option if you want sound clips to be 

automatically attached to video clips. For example, you may have some background music 
on your soundtrack that you want to always play at the same time as one of your video 
clips. If this feature is enabled, placing the sound clip at the same timeline position as your 
video clip will link them. Then, if you move your video clip around on the timeline, the sound 
clip will automatically move too. (Note the video clip must have a longer or equal duration.)

Transitions
Note: Any changes to transitions options will not be applied to slides already on the sequence. 
● Default transition duration - Specify the default duration of transitions applied to slides on 

the sequence in seconds.
● Default transition type - Choose the default transition type from the list. Note: It is not 

possible to select Morph as the default transition type because morph lines need to be 
drawn over similar features of the slides involved. 

● Add transitions automatically - Tick this box to automatically add a transition to any slide 
you add to the sequence.

● Randomize transition type - Tick this box to randomize the type of transition used when an 
automatic transition is applied. If not ticked, automatic transitions will use the default 
transition type. 
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Screen References - Options ~ Media Files
The Media Files tab is where you can select the way PhotoStage works with media files.
Removable Media 
● Ask to add files to the project when removable media is connected to PC - Tick this box to 

automatically detect newly connected media.
● You can select the way to handle the added file from removable media (e.g. flash drive or 

CD).
● You can select a folder to save the added file from removable media.
Save to Folder  
● Select a folder to save converted files.
● Select a folder to save snapshot files.
Media Formats  
● Save audio narrations as MP3 or WAV.
● Save audio tracks as MP3 or WAV.
● Save snapshots as JPG or PNG.
● MP3 Settings - you can set the MP3 encoder options.
● Snapshot resolution - you can choose the resolution that the snapshot will have.
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Screen References - Options ~ Other
The Other tab is where you can adjust additional settings.
Other Settings  
● Select an action you want to perform when sound clips overlap: you can choose between A

sk me , Cut the active clip or Push clips right . 
● Select where you want to add new slides to the sequence by default: choices are Ask me , 

, Beginning of the timeline or End of track. 
● Choose if you want to show the video quality settings dialog when converting and 

stabilizing video files. 
● Choose if you want to fade the volume of sound clips automatically when they overlap. 
● Choose if you want to open the Edit tab when a slide is selected. 
Burning 
● To make changes to disc burning process you can adjust settings in "Burning" group. 
External Editors (leave blank for default) 
● Select external applications you want to use to edit different types of files. Leave any field 

blank in you want to use default editor. To edit a file in external editor right click a media in 
the Media List tab and select "Edit in external editor..." For more information on how to use 
external editors, see Editing in an External Editor 
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Screen References - Options ~ Speech to Text
Select a speech to text engine which PhotoStage can use to automatically generate subtitles 
for your video.
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